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Laois and Offaly ETB

Programme Module for 

Data Entry Skills
leading to 

Level 4 QQI  

Data Entry 4N1113

Introduction
This programme module may be delivered as a standalone module leading to certification in a QQI minor award. It may also be delivered as part of an overall validated programme leading to a Level 4 QQI Certificate. 
The teacher/tutor should familiarise themselves with the information contained in Laois and Offaly ETB’s programme descriptor for the relevant validated programme prior to delivering this programme module. The programme module is structured as follows:

	1. Title of Programme Module

	2. QQI Component Title and Code

	3. Duration in hours

	4. Credit Value of QQI Component

	5. Status

	6. Special Requirements

	7. Aim of the Programme Module

	8. Objectives of the Programme Module

	9. Learning Outcomes

	10. Indicative Content

	11. Assessment

a. Assessment Technique(s)

b. Mapping of Learning Outcomes to Assessment Technique(s)

c. Guidelines for Assessment Activities

	12. Grading

	13. Learner Marking Sheet(s), including Assessment Criteria


Integrated Delivery and Assessment

The teacher/tutor is encouraged to integrate the delivery of content where an overlap between content of this programme module and one or more other programme modules is identified. This programme module will facilitate the learner to develop language, literacy and numeracy skills relevant to the themes and content of the module. 
Likewise the teacher/tutor is encouraged to integrate assessment where there is an opportunity to facilitate a learner to produce one piece of assessment evidence which demonstrates the learning outcomes from more than one programme module. The integration of the delivery and assessment of level 4 Communications and level 4 Mathematics modules with that of other level 4 modules is specifically encouraged. 

Structured communication and teamwork is encouraged between the teacher/tutor delivering this programme module and the language, literacy, numeracy and learning support teacher/tutor, as appropriate, to facilitate the learner in completing the programme module and achieving certification in the award.
Indicative Content
The indicative content in Section 10 does not cover all teaching possibilities. The teacher/tutor is encouraged to be creative in devising and implementing other approaches, as appropriate. The use of examples is there to provide suggestions. The teacher/tutor is free to use other examples, as appropriate. The indicative content ensures all learning outcomes are addressed but it may not follow the same sequence as that in which the learning outcomes are listed in Section 9. It is the teacher’s/tutor’s responsibility to ensure that all learning outcomes are included in the delivery of this programme module.
1. Title of Programme Module

Data Entry Skills
2. Component Name and Code 

Data Entry 4N1113
3. Duration in Hours
100 Hours (typical learner effort, to include both directed and self-directed learning)
4. Credit Value

10 
5. Status
This programme module may be compulsory or optional within the context of the validated programme. Please refer to the relevant programme descriptor, ‘Section 9 Programme Structure’.
6. Special Requirements

None
7. Aim of the Programme Module
The aim of this programme module is to enable the learner to become proficient in inputting data accurately as well as developing good standards of document production and proof reading skills.

8. Objectives of the Programme Module

· To explore with the learner the importance of data entry skills in a range of work environments. 
· To familiarise the learner with a data entry application in order to build their typing skills to a high degree of speed and accuracy.
·  To enable the learner to confidently create, edit and format a range of documents.
·  To assist the learner to acquire good proof reading and correction skills following standard grammatical structures and rules. 
· To assist the learner to develop the language, literacy and numeracy skills related to data entry through the medium of the module themes and content.

· To enable the learner to take responsibility for his/her own learning.
9. Learning Outcomes of Level 4 Data Entry
Learners will be able to:
1. Explain the importance of speed and accuracy in relation to data entry.
2. Use a data entry application to enter data using text, alpha, numeric and special characters.

3. Create a range of documents using appropriate text production techniques for punctuation and style.

4. Use a range of editing and formatting tools.

5. Make amendments to documents using insert, delete, change case, transpose, and new paragraph functions.

6. Copy text consisting of a minimum of 250 words, including character and numeric data, to a minimum speed of 25 words per minute and a minimum of 98% accuracy. 
7. Proof read a single one page, double line spacing document containing a range of errors to identify errors and indicate required corrections. 
10. Indicative Content 

This section provides suggestions for programme content but is not intended to be prescriptive. The programme module can be delivered through classroom based learning activities, group discussions, one-to-one tutorials, field trips, case studies, role play and other suitable activities, as appropriate.

The Learner must gain competence in a data entry application and reach a minimum typing speed of 25 words per minute with 98% accuracy. They must also be able to produce and manipulate a range of documents, check for and correct errors appropriately. 

Section 1: Speed & Accuracy in a Working Context 
Facilitate the learner to explain the importance of:

· Speed in relation to data entry in the work environment, for example:
· Note taking
· Recording meeting minutes
· Dictation
· Scribing
· Accuracy in relation to data entry in the work environment, for example:
· Legal Professions
· Banking
· Accountancy
· Government

Section 2: Inputting & Copying Data
Facilitate the learner to use a data entry application e.g. Microsoft Word to enter data using:

· Alpha and numeric keys

· A-Z both upper and lower case using the Shift & Caps Lock Keys

· 0-9 numerical keys using the Num Lock Key

· Special Characters

· Use the Shift Key and number keys 0-9 to enter special characters, for example, !, £, %, &. Note the use of the Alt Gr and number 4 key to enter the € symbol.

· Use the peripheral keys to enter both their main symbols and their 2nd function symbols, for example, the bracket keys [ ] 2nd Function { }

· Use the Insert Tab to Insert Symbols and Equations, for example, →, ↕, ©, [image: image3.png]



· Facilitate the learner to gain a minimum typing speed of 25 words per minute with 98% accuracy. There are a wide range of free typing websites which facilitate learners to build their speed and accuracy, for example,

· www.typingweb.com – allows you to create a class and to track progress

· www.typingtest.com  - provides basic tests for measuring typing speed and accuracy. 

Section 3: Document Production & Editing
Facilitate the learner to create a range of documents using appropriate text production techniques for punctuation and style, for example, 

· Formal Letter 

· Inter – office Memo

· Business E-mail

· Reports

Facilitate the learner to use a range of:

· Editing tools, for example,
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 Spelling & Grammar Check
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 Font Type & Size
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 Font Colour
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  Bold, Italics and Underline Functions
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Increase or Decrease Font
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  Text Highlighting
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Cut 
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Copy
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 Paste
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 Find text or other content in a document
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 Replace text in a document

· Formatting tools, for example, 
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 Bullets or Numbering Styles
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Text and Image Alignment
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 Page Layout Options
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 Header, Footer & Page Numbering
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from the paragraph dialog box on the Home Tab

Facilitate the learner to make amendments to documents using:

· Insert, for example,
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  Tables

· [image: image22.png]LB 2l o

Pidure Clip  Shapes Smartart Chart Sareenshot
At -




 Illustrations & Charts
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 Header, Footer & Page Number Options
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          Word Art
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Hyperlinks
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Cover Page Templates for Reports
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 Insert a comment into a report or document

· Delete individual words, pieces of text, charts or illustrations.
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Change Case - Change all the selected text to upper or lower case, capitalise each word or toggle case. 

· Transpose – Switching the orientation of columns to rows or vice versa when designing or using charts.

· New paragraph functions – use the Tab Key to indent or set your own indentation from the Page Layout Tab - [image: image29.png]Indent.




 or use the Paragraph Function on the Home Tab
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Section 4: Proof Reading

Facilitate the learner to develop proof reading skills enabling them to identify and correct a document containing typing, punctuation and grammatical errors.

· Typing errors, for example,

· Word repeated

· Sentence repeated

· Word misspelt 

· Word omitted 

· Punctuation errors, for example,

· Using a comma instead of a full stop.

· Using a semi-colon instead of a full-colon.

· Extra space between words using the[image: image31.png]


key on the home tab

· Single space after a full stop using the[image: image32.png]


key on the home tab

· Grammatical errors, for example,

· Incorrect case used

· Incorrect tense used

· Incorrect personal pronouns used

· Incorrect homophone used

11. Assessment
11a.
Assessment Techniques

Examination – Practical 100%
11b.
Mapping of Learning Outcomes to Assessment Techniques
In order to ensure that the learner is facilitated to demonstrate the achievement of all learning outcomes from the component specification; each learning outcome is mapped to an assessment technique(s). This mapping should not restrict an assessor from taking an integrated approach to assessment.
	Learning Outcome
	Assessment Technique

	1. Explain the importance of speed and accuracy in relation to data entry.
	Examination 3

	2. Use a data entry application to enter data using text, alpha, numeric and special characters.
	Examination 2

	3. Create a range of documents using appropriate text production techniques for punctuation and style.
	Examination 2

	4. Use a range of editing and formatting tools.
	Examination 2

	5. Make amendments to documents using insert, delete, change case, transpose, and new paragraph functions.
	Examination 2

	6. Copy text consisting of a minimum of 250 words, including character and numeric data, to a minimum speed of 25 words per minute and a minimum of 98% accuracy.
	Examination 1

	7. Proof read a single one page, double line spacing document containing a range of errors to identify errors and indicate required corrections.
	Examination 3


11c.  
Guidelines for Assessment Activities

The assessor is required to devise examination papers, marking schemes and outline solutions for the examinations.  In devising the examination papers, care should be taken to ensure that the learner is given the opportunity to show evidence of achievement of ALL the learning outcomes. Assessment briefs may be designed to allow the learner to make use of a wide range of media in presenting assessment evidence, as appropriate. Quality assured procedures must be in place to ensure the reliability of learner evidence.
	Examination 1 - Practical
	Weighting 60%

	Time Allocation: 10 Minutes

	The learner must complete a copy test consisting of a minimum of 25 words per minute with a minimum of 98% accuracy.  
Text must consist of:

· Character Data
· Numeric  Data

Please note that a word consists of 5 keystrokes. 
Procedure for calculating Speed:
· Count the number of keystrokes typed

· Divide the keystrokes by 5 to obtain the words typed

· Divide the words typed by 10 to obtain the Speed in wpm

· If the speed is greater than or equal to 25wpm then award Yes for Speed

Procedure for calculating Accuracy:

· Multiply the words typed by 2% to obtain the number of errors allowed

· Calculate the number of errors using the procedure below

· If the number of errors is less than or equal to the number of errors allowed then award Yes for Accuracy 
Procedure for calculating Errors:

· The following constitute 0.5 error

· Incorrect case

· Incorrect punctuation

· Extra space between words

· Single space between sentences

· The following constitute 1 error

· Errors in a single word

· Word omitted

· Extra word inserted

· Word repeated

· Line repeated

· The following constitutes 2 errors

· Line omitted

Evidence for this assessment technique should be a printed copy of the learner’s work.   Printing time is not included in the time allocated to complete the test.

All instructions for the learner must be clearly outlined in an examination paper.



	Examination 2 - Practical
	Weighting 20%

	Time Allocated: 20 Minutes

	The learner will complete an examination relating to document production where they will produce a business document from given data to include the following:
· Using a data entry application to enter data using text, alpha, numeric and special characters.

· Creating a document using appropriate text production techniques for punctuation and style.

· Using a range of editing and formatting tools.

· Making amendments to the document using insert, delete, change case, transpose, and new paragraph functions.

Evidence for this assessment technique should be the learner’s printed document incorporating the amendments specified.   Printing time is not included in the time allocated to complete the exam.
All instructions for the learner must be clearly outlined in an examination paper.



	Examination 3 - Practical
	Weighting 20%

	Time Allocated: 30 Minutes 

	This examination relates to proof reading and requires the learner to explain the importance of speed and accuracy in relation to data entry.
· The learner will be required to proof read a single one page, double line spacing document containing a range of errors to identify errors and indicate required corrections.
· The learner will be required to explain, giving examples, the importance of speed and accuracy in relation to data entry.
Evidence for this assessment technique will be the proof read document with the errors identified and corrections indicated as well as a concise explanation of the importance of speed and accuracy in data entry with examples provided.
All instructions for the learner must be clearly outlined in an examination paper.


12. Grading

Distinction: 
80% - 100% 

Merit:

65% - 79%

Pass: 

50% - 64%

Unsuccessful:
0% - 49%

At levels 4, 5 and 6 major and minor awards will be graded. The grade achieved for the major award will be determined by the grades achieved in the minor awards.

	Data Entry

4N1113
	Learner Marking Sheet

Examination 1 60%


Learner’s Name: ________________________________
	Assessment Criteria
	Competent 

Yes / No 

	Copy text consisting of a minimum of 250 words, including character and numeric data, to a minimum of 98% accuracy

Note: A word consists of 5 keystrokes.
	

	Speed:  Minimum of 25 words per minute (as outlined below)
	

	Accuracy:  Minimum 98% (as outlined below)
	

	Total Mark  (60 OR 0)
Award 60 marks if competent (yes) in both Speed and Accuracy
	


Procedure for calculating Speed:

· Count the number of keystrokes typed

· Divide the keystrokes by 5 to obtain the words typed

· Divide the words typed by 10 to obtain the Speed in wpm

· If the speed is greater than or equal to 25wpm then award Yes for Speed

Procedure for calculating Accuracy:

· Multiply the words typed by 2% to obtain the number of errors allowed

· Calculate the number of errors using the procedure below

· If the number of errors is less than or equal to the number of errors allowed then award Yes for Accuracy 

Procedure for calculating Errors:

· The following constitute 0.5 error

· Incorrect case / Incorrect punctuation

· Extra space between words / Single space between sentences

· The following constitute 1 error

· Errors in a single word / Word omitted / Extra word inserted

· Word repeated / Line repeated

· The following constitutes 2 errors

· Line omitted

NO ROUNDING OF MARKS

The Assessor has signed the Summary Results Sheet to verify that the evidence presented in the attached portfolio is the work of the named learner and that the marks awarded here have been transcribed to the Summary Results Sheet

External Authenticator's Signature: ............................................................   Date: ...............................

	Data Entry

4N1113
	Learner Marking Sheet

Examination 2 20%


Learner’s Name: ________________________________
	Assessment Criteria
	MaximumMark
	LearnerMark

	The learner will complete an examination relating to document production where they will produce a business document from given data to include the following:

· Using a data entry application to enter data using text, alpha, numeric and special characters.

· Creating a document using appropriate text production techniques for punctuation and style.

· Using a range of editing and formatting tools.

Making amendments to the document using insert, delete, change case, transpose, and new paragraph functions. Based on a one page document with 8 handwritten amendments:



	Layout – Deduct 1 Mark per incorrect layout of the following:

· Date

· Reference / Subject

· Correct Salutation

· Correct Close
	4
	

	Amendments – 8 amendments, equivalent to 8 errors 

· Deduct 1 Mark per error to a maximum of 8
	8
	

	Errors – Deduct 1 Mark per error to a maximum of 8:

· The following constitute 0.5 error

· Incorrect case / Incorrect punctuation

· Extra space between words / Single space between sentences

· The following constitute 1 error

· Errors in a single word / Word omitted / Extra word inserted

· Word repeated / Line repeated

· The following constitutes 2 errors

· Line omitted
	8
	

	Total Mark
	20
	


NO ROUNDING OF MARKS

The Assessor has signed the Summary Results Sheet to verify that the evidence presented in the attached portfolio is the work of the named learner and that the marks awarded here have been transcribed to the Summary Results Sheet

External Authenticator's Signature: ............................................................   Date: ...............................

	Data Entry

4N1113
	Learner Marking Sheet

Examination 3 20%


Learner’s Name: ________________________________


	Assessment Criteria
	MaximumMark
	LearnerMark

	Proof read a single one page, double line spacing document containing a range of errors to identify errors and indicate required corrections.  
The document should include:
· 5 Spelling errors

· 3-4 Lines of text which are duplicated but with ten differences between the blocks of text

Award 1 Mark for each error identified and appropriate correction indicated.
	15
	

	Explain the importance of speed & accuracy in relation to data entry giving examples.

	5
	

	Total Mark
	20
	


NO ROUNDING OF MARKS

The Assessor has signed the Summary Results Sheet to verify that the evidence presented in the attached portfolio is the work of the named learner and that the marks awarded here have been transcribed to the Summary Results Sheet

External Authenticator's Signature: ............................................................   Date: ...............................
Doc No: 47N1113-02
Effective Date: 1st September 2020 
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